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Overview

This document provides usage, configuration and installation instructions for the “Enterprise Add-On for Autodesk Vault”, as
developed by Autodesk Consulting. In this document the short form "Vault Add-On" or VAO will be used.

History of changes

Date Author Notes
25/08/2011 Fabian Peters Initial version
15/09/2011 lan Carr Update for release 1.2.0
27/09/2011 lan Carr Update for release 1.3.0
30/09/2011 Fabian Peters Update support model
06/10/2011 Fabian Peters Minor corrections
01/11/2011 lan Carr Update for 1.4.0
16/11/2011 Dominik Leuthold Update for 1.4.1
17/04/2012 Rainer Prohl Minor corrections
14/06/2012 Michael Sosnik Release for 2013
21/06/2012 Luca Bazzocchi Update for 2013 Release
27/07/2012 Rainer Préhl Product name update, Minor corrections
27/09/2012 Michael Sosnik Describing the functionality — New Main Topic
31/10/2012 Michael Sosnik Further Editions (throughout whole document); Added VGet
15/11/2012 Dominik Leuthold Added multiple small additions
10/06/2013 Thomas Helm Release for 2014
Goal

The Enterprise Add-On for Autodesk Vault is a set of productivity tools that are integrated with Vault 2014

following functionalities:

Property Management
Publish Jobs

Clone Structure
Drawing Compare
E-Mail Notification
Object Classification
Four Eyes Check
Content Center Part Generator
Vault User Accounts
Import Object Properties
Import Property List
Import Folder Structure
Object Link Browser
VGet

. It provides
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Installation

System Requirements

The Enterprise Add-On for Autodesk Vault supports Vault 2014 product family (Vault Workgroup, Vault Professional), Autodesk
Inventor 2014 and AutoCAD (Civil 3D) 2014. Software and hardware requirements of the Enterprise Add-On for Autodesk Vault
are identical with Autodesk software.

The Vault Addon 2014 wills deliver in two different installers which contains installs for 32 and 64 bit clients. The installs are
MSI files and are executed from the setup.exe. The contents of the Zip are as follows:

File Notes

Setup.exe Main setup executable

AC Vault-Add-On Guide 2014.pdf Enterprise Add-On for Autodesk Vault 2014 Installation, Configuration and
Usage Instruction

x64/VaultAddOn.msi 64 bit install file

X86/VaultAddOn.msi 32 bit install file

The installer in Vault Addon 2014-Complete-n.n.n.zip contains all components. The installer in Vault Addon 2014-NFR-n.n.n.zip
not includes the following components:

Content Part Generator

Vault User Accounts

Import Folder Structure

Import File and Item Properties
Import Property List

Install Enterprise Add-On for Autodesk Vault 2014

To install the Enterprise Add-On for Autodesk Vault follow these steps.

PWN =

Stop the Job Processor service if running.’

Copy the Vault Addon 2014-Complete-n.n.n.zip to a local directory and unzip.
Run the setup.exe

Select the next button to progress the install.

1 This is highly recommended since as part of the installation process, new Job types will be available. Stopping the service before the
installation will ensure that all the changes take effect properly.
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ﬁ Enterprise Add On for Autodesk Vault 2014 Setup E| (=] |@

Back [ Next ] [ Cancel

5. Read and agree to the license terms and condition. Check the agree check box. Then select the next button to progress
the install.

#5 Enterprise Add On for Autodesk Vault 2014 Setup E| [=] |@

Autodesk

| »

LICENSE AND SERVICES AGREEMENT

READ CAREFULLY: AUTODESK LICENSES THE SOFTWARE AND OTHER
LICENSED MATERIALS OMLY ON THE CONDITION THAT LICENSEE
ACCEPTS ALL OF THE TERMS CONTAINED OR REFERENCED IN THIS
AGREEMENT.

By selecting the “l accept” button or other button or mechanism designed to
acknowledge agreement to the terms of an electronic copy of this Agreement, or

by installing, downloading, accessing, or otherwise copying or using all or any
portion of the Autodesk Materials, (i) you accept this Agreement on behalf of the —

I accept the terms in the License Agreement

Print ] [ Back “ Next | [ Cancel

6. Review and select the features and location of the target installation folder. Then select the next button to progress the
install.
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[ gl Standalone Tools
--------- gl Object Classification
--------- gl Clone Structure

--------- gl Email Notification
--------- =3~ | Four Eyes Check
--------- gl Object Link Browser
......... gl Help

= gl Publish Jobs

[ »

11

Installs complete package.

This feature requires 896KB on your
hard drive. It has 10 of 10
subfeatures selected. The
subfeatures require 11MB on your
hard drive.

4 | 1 |
Location: C:\Program Files\Autodesk\VAO 2014
Reset ” Disk Usage ] [ Back ][ Next J[ Cancel ]

Note: on a 64 bit maschin the Drawing Compare feature is not supported and therefor not
selectable.

ﬁl Enterprise &dd On for Autodesk Wault 2014 Setup

Click. the icons in the tree below to change the way Features will be installed.

& Qvl Enterprise Add Cn
[+]-- =0~ | Skandalone Tools

Clone Skructure

Ernail Matificakion
Four Eves Check,

iq 1} |

Object Classification

Drawing Carmpate

Cbject Link Browser

.

-

Installs Drawing Compare Add-In.

This Feature requires 32KE on your
hard drive,

Browse. ..

Reset ][ Disk. Usage

J

Back. ][ Mt J [ Cancel

Note: on a 32 bit maschine the Drawing Compare is available

Select the next button to progress the install.
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42 Enterprise Add On for Autodesk Vault 2014 Setup o] @[ =

Click Install to begin the installation. Click Back to review or change any of your installation
settings. Click Cancel to exit the wizard.

Back | Install | | cancel

8. Theinstallation is complete.

8 Enterprise Add On for Autodesk Vault 2014 Setup (o = [=]

Back “ Finish I ‘ Cancel

9. Restart the Job Processor service.

If you have issues with the installation then the MSI can be run manually to generate a log file of the install. To run the install
manually follow these steps.

1. Stop the Job Processor service if running.
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2. Copythevault Addon 2014-Complete-n.n.n.zip to a local directory and unzip.

3. Open a command window at the location of the MSI file that matches you operating system version.
4. Runthe MSI manually usingmsiexec /i VaultAddOn.msi /L install vao.log

5. Follow the steps above and then review the log file.

6. Restart the Job Processor service.

Post Install Enterprise Add-On for Autodesk Vault 2014 Tasks

To verify that the commands are visible in Vault client, select Tools in the menu. The Enterprise Add On is available.

Tools | Actions Help

Enterprise Add On »
A8 Find.. Ctrl+F
J]ﬂ Workspace Sync...

If the Enterprise Add On isn’t available, it's required to reset the menu:

1. Run Vault Client and connect to your Vault server.
2. InVault Explorer go to Tools Customize.

3. On Toolbars tab select “Main Menu” then click on “Reset”. This step will “reset” user interface to default state.

Property Management

A file property in Vault is the information about a document stored in vault. The file properties are visible and accessible only
inside the Vault. The user can create own (“user defined”) properties.

The properties of a file (stored on file level) exist independently of Vault (e.g. iProperty for Inventor files or properties of a doc-
file) and can be mapped to Vault file properties.

The property management is used to edit properties on file level. The main purpose of the property management is to provide
an “easy” way for a CAD manager to provide property templates where user can enter document properties prior adding
documents to the Vault.

It consists of two parts:

Synchronize

e Inventor Add In

e Works for drawings only

e  Copies designated properties automatically from model document to the drawing
e  Based on definitions uploaded to the Vault the user is connected to

Edit Properties

e Inventor Add In
e  Provides an interface in Inventor to edit Vault properties with (from Inventor)
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According the configuration it is possible to validate properties against selected schema. A dialog will be displayed in case of
error. Please note that there is no way to force dialog on every save. If properties changed outside of the dialog and marked as
mandatory the check-in will failed and a message box is displayed.

Configuration

The property management utility enables access to Vault properties in Inventor and AutoCAD clients. The configuration of
property schemas is stored in XML file.

Make sure that all properties are created in vault prior to configuring the XML File.

The example Properties.xml file should be located in

C:\Program Files\Autodesk\VAO 2014\Configuration\Property Management.

The XML file can contain the following elements:

Element Name Attribute Name Description
Property Options Main configuration.
SynchronizeOnSave Specifies if the properties should be synchronized after the

properties have been saved.

ValidateOnSave Specifies if the mandatory properties should be checked when
the properties are being saved.

ValidateOnCheckin Specifies if the mandatory properties should be checked before
file will be checked in to Vault
PropertySchemas Contains one or more property schemas.
PropertySchema Contains one or more property sets.
Name Name of schema. Must be unique.
FileType List of supported file extensions. Vertical bar is used as
separator.
Default If true then schema is sued as default for given file type.
PropertySet Contains one or more properties.
Name Name of property set.
Property Defines property.
Name Name of property.
Required Is true then property value must be specified.
DataSourceType Data source type of the property:

“VaultProperty” — the source for property is Vault property.
“VaultFile” - the source for property is file in Vault.
“Expression” — the source for property is expression.
Inventor.Model — the source for property is the Inventor model

Inventor.Parameter — the source for property is an Inventor
parameter

Autodesk [and other products] are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries.
All other brand names, product names, or trademarks belong to their respective holders. Autodesk reserves the right to alter product and services offerings, and
specifications and pricing at any time without notice, and is not responsible for typographical or graphical errors that may appear in this document.

© 2013 Autodesk, Inc. All rights reserved.
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Element Name Attribute Name Description

DataSource Contains data source for the property. Depends on
“DataSourceType”.

Source file must be inside Vault.

For the DataSourceType “VaultFile” two DataSources file types
are possible:

e csv—files are used for defining a list of values which
should appear in the defined editor?

e csv—files are used for defining a list of replaced values
using the DataSource — Lookup - keyword?

e xml—files are used for defining a selection set
depending on a previous selection of the user? -

XmlQuery
Target Specifies where value is stored.
DefaultValue Optional: Can contain default values
Editor Defines the editor user will be able to use when editing the

values. They all belong to the type
“Autodesk.VaultToolkit.PropertryEditor.Editors.*”

The following editors exist:

e  TextBoxEditor
e  ValuelListEditor
e DataTableEditor

Override Optional element which can be used to override DataSource
based on the simple condition.

Condition Simple condition for equality test:
[PropertyName]=[Value]

If result is true then DataSource in property is replaced with
associated value.

DataSource Alternate data source.

Property Synchronization

Inventor Add-In can automatically synchronize properties between the Inventor model and drawing. The properties can be
specified using SynchronizedProperty element.

2 Example: In the file C:\Program Files\Autodesk\WAO 2014\Configuration\Property Management\Properties.xml; PropertySet
Name="Common". The reference to the DataSource “$/Configuration Files/Titles.csv” is used for showing a list of titles.

3 Example: In the file C:\Program Files\Autodesk\WAQO 2014\Configuration\Property Management\Properties.xml; PropertySet
Name="Rotation (CSV Data)". The reference to the DataSource “Lookup{{RotationData.DataSource}, {Rotation}, 1, 2)" is used
for replacing the 1% value of the list with the 2" value.

4 Example: In the file C:\Program Files\Autodesk\VAO 2014\Configuration\Property Management\Properties.xml; PropertySet
Name="Product (XML Data)” the DataSources “XMLQuery” are used to determine a selection. The values are shown in the
Property Data.xml (referenced in the first DataSource parameter.

{\ AUTODESK.
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Element Name Attribute Name Description

SynchronizedProperties

Defines list of properties for synchronization.

SynchronizedProperty Defines property for synchronization.
Name Name of the property in a full Inventor definition — (see code
example)
Note

An example XML File is included in the

C:\Program Files\Autodesk\VAO 2014\Configuration\Property Management.
The configuration needs to be imported into Vault via the XML file before using Inventor add-in.

Without this action Inventor will not be aware about the needed actions to perform.

Reading the information is performed in an on-line mode from the dataset and not from file.
Changes to the Vault configuration will immediately change the next property assignment

performed on the network from any connected client.
The function is not available when not connected to Vault.

Property Names

Document property names can be specified using following syntax:

PropertySet.PropertyName

Following property set names are supported for Inventor:

DesignTrackingProperties
Summarylnformation
DocumentSummarylnformation
UserDefinedProperties

Import Configuration

To import configuration use following steps:

1. Run Vault Explorer.
2. Goto Tools =» Enterprise Add-On =>» Settings.
3. In Settings dialog under tab Property Management select Import configuration.
4. Select XML file for import.
Export Configuration

To export configuration use following steps:

PWhN =

12

Run Vault Explorer.

Go to Tools =» Enterprise Add-On =>» Settings.

In Settings dialog under tab Property Management select Export configuration.
Enter name for XML file.
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¥4 Vault Add On Settings

Import Property Management configuration from a XML file into Vault

l Import Configuration I

Export Property Management configuration from Vault to a XML file.
l Export Configuration I

=

| Object Classification | E-Mail Notification | Four Eyes Check | Property Management | Publish Jobs

OK l [ Cancel

Usage

The command for property management is available in Inventor and AutoCAD.

AutoCAD Add-In
The VTKEDITPROPERTIES command is available after loading of AutoCAD.

Inventor Add-In
The Inventor Add-In commands are available in the Vault ribbon under VAO panel:

The commands require an active connection to the Vault.

INZII Autodesk 360 -

. = ,
IE:"::J &A
2 Change Change Get Revise | Edit Properties

es (Category State Revision

Control VAOD

Synchronize Properties

The command is available only for drawing documents. It copies selected properties from associated model document to the

drawing. All based on the definitions uploaded to the Vault Server the user is connected to.

It's possible to copy properties manually (using command) or automatically.

The automatic synchronization is executed within the document save action with the interactive Inventor session. It will not be
executed with a JobServer driven save process. During the JobProcessor actions all Inventor addins are usually disabled by

default.

If mandatory properties defined for the drawing schema model and be empty, the edit properties dialog appears. Are all

properties filled in or optional, the dialog will not open automatically after the first save process.
Autodesk 360

[ ] Bo \ E‘ : @
5o [0 O[A)
Update Change Change Get Revise | Edit Properties |Synchronize

ptions Properties = Category State Revision
| Control | VAO |

= -

ards

13
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Edit Properties

The Edit properties command provides advanced user interface for selection of property values. The command is enabled only if

connection to Vault server is established.

INZII Autodesk 360

F &G
2 Change Change Get Revise

es (Category State Revision
Control VAO

g

Edit Properties

The “Inventor Part” Property Schema and the four named Property sets (“Common”, “Product”, “Rotation” and “Material”)
correspond to the Property sets defined in the property.xml mentioned in the configuration — chapter (Property

Management) of this document.

% | Property Editor @

Document

C:\Working\Designs\Sheet metal parts\100119.ipt

Froperty Schema

Inventor Part -

Search R

Name Value

-

[+ Common

Product (XML Data)
- Rotation (CSV Data)
Material (CSV Data)

[ ok ][ concel

Note:

e  The value of mapped iProperties will be updated after click OK
e To map the properties back to Vault it is necessary to configure the Vault property mapping

14
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E Property Definitions . u
=i = Get Usage Counts
T Property Name + | Data Type State Usage As: *
| Gasket Type Text & Enabl... File
‘TB|GeoRss Text % Enabl... File
» B Group Text T Enabl... File
B Header Text Filel=
T Hidden Boolean (True or False) File
‘@| iLogicRuleStatus Text File
'@| Initial Approver Text File
‘@| Initial Release Date Date File
B Installation Text Rel ™
< I | r
Entity Provider / File Property Type Classification Mapping Crea..
=l Provider: AutoCAD
‘ File |AutoCAD | Group |Text | Custom | mel ‘Yes
= Provider: Inventor
‘ File |Inven‘[or | Group |Text | Custom | e ‘Yes
I Close I l Help
DataTable Example

1. Click on Edit Properties command in Vault Tools panel.
2. In the Property Editor locate the title property. Mandatory properties are highlighted with bold font.
3. Click on ... next to property value.

Search

o)

X

Name

=+ Common

- Job Mumber

- Group

- Matenal Type

- Job Organization
- Machining Code

- Title GER

Value

11

4. In the Data Table dialog locate new property value.

15

{\ AUTODESK.



5.

16

% DataTable

Search

P x

English

progressive safety gear

Deutsch

Bremsfangvorrichtung

car buffer

Kabinenpuffer

car sliding guide shoe

Kabinen-Gleitfiihrungsschuh

sill support

Schwellentrager

Esafety gear body

Fanggehduse

car floor

Kabinenboden

car operating panel

Kabinentableau

-y PR

o s am ol

(0] ] [ Cancel

% represents series of characters

_ represents single character

The search option on top bar, searches for possible matches over all columns (highlighted in blue)

% DataTable

-y PR

o s am ol

Search Sa P X lof3
English Deutsch sl
progressive safety gear Bremsfangvorrichtung -
car buffer Kabinenpuffer ]
car sliding guide shoe Kabinen-Gleitfiihrungsschuh D
sill support Schwellentrager

3 Esafety gear body Fanggehduse
car floor Kabinenboden
car operating panel Kabinentableau i

(0] ] [ Cancel

Close dialog “Data Table” with OK button.
Search

Name

=+ Commaon

- Job Mumber

- Group

- Matenal Type

- Job Organization
- Machining Code
- Title

- Tithe GER

Value

safety gear body

Fanggehause

»

m

The dialog uses same grid as Vault. Thus it's possible to use same method for data sorting and filtering. When using
custom filter following placeholder characters could be used:
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In the properties.xml file, the code looks as follows:

<Property Name="TitleData" DataSourceType="Vault.File" DataSource="$/Configuration Files/Titles.csv"
Visible="false" />
<Property Name="Title" Required="true" DataSourceType="Vault.File" DataSource="$/Configuration Files/Titles.csv"
Target="SummaryInformation.Title">

<Editor Type="Autodesk.VaultToolkit.PropertyEditor.Editors.DataTableEditor"/>
</Property>
<Property Name="Title GER" Required="false" DataSourceType="Expression" DataSource="Lookup ({TitleData.DataSource},
{Title}, 1, 2)" Target="UserDefinedProperties.Title GER" />

LookUp Example

The LookUp example of property edition is the following one.

1. Select the Property set Rotation
2. In the Property Editor locate the Rotation property. Mandatory properties are highlighted with bold font.
3. Select a value from the drop down list

Search e

Name Value o
G- Product (XML Data) i
= Rotation (CSV Data)

. Rotation Allowed 0 I—
(i} Material (CSV Data) i
180 |
270

4. The Rotation Allowed is calculated from the Rotation value above.
Search e

Name Value o
G- Product (XML Data) i
= Rotation (CSV Data)

- Rotation 90
» & Rotation Allowed ‘N i

[} Material (CSV Data) -

The Edition of the Rotation (CSV Data) Property Sets is supported by the definition in the file Rotation.csv mentioned in the
configuration — chapter (Property Management) of this document.

In the properties.xml file, the code looks as follows:

<Property Name="RotationData" DataSourceType="Vault.File" DataSource="$/Configuration Files/Rotation.csv"
Visible="false" />
<Property Name="Rotation" Required="true" DataSourceType="Vault.Property" DataSource="Rotation"
Target="UserDefinedProperties.Rotation">

<Editor Type="Autodesk.VaultToolkit.PropertyEditor.Editors.ValueListEditor" />
</Property>
<Property Name="Rotation Allowed" Required="true" DataSourceType="Expression"
DataSource="Lookup ({RotationData.DataSource}, {Rotation}, 1, 2)" Target="UserDefinedProperties.Rotation Allowed"
/>

XmlQuery Example

The XmlQuery feature provides referenced list values related to the value from another list.

1. Select the Property set Product

{\ AUTODESK.
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Search

Name Value

LS Common

=) Product (XML Data)
Product Group
- Product Family
i Product Model
4 Rotation (CSV Data)
- Material (CSV Data)

In the Property Editor locate the Product Group property. Mandatory properties are highlighted with bold font.

Select a value from the drop down list
Search

P X

Name Value

[+ Comman

[t} Material (CSV Data)

The values from property Product Family are now selected by the Value “Group 1”

Search

ol 4

Name Value
[+ Comman

El Product (XML Data)

. Product Group Group 1

g Product Family EFamily 1B

| i Product Model Family 1A
[ Rotation (CSV Data)

Family 1B

: Family 1C
[+ Material (CSV Data)
Select a value from the drop down list
Search P x
MName Value
- Commaon
£} Product (XML Data)
. Product Group Group 1
- Product Family Family 1B

§ Product Model |

- Rotation (CSV Data)
[ Material (CSV Data)

The values from property Product Model are now selected by value “Family 1B”
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Search P x

Name Value
[ Common

= Product (XML Data)

» - Product Group Group 1

- Product Family Family 1B

[ Material (CSV Data) Model 182

i Rotation (CSV Data) Model 181

w

In the properties.xml file, the code looks as follows:

<Property Name="ProductData" DataSourceType="Vault.File" DataSource="$/Configuration Files/Property Data.xml"

Visible="false" />
<Property Name="Product Group" Required="true" DataSourceType="Expression"

DataSource="XmlQuery ({ProductData.DataSource}, //Data/ProductGroup/@Name)" Target="UserDefinedProperties.Product

Group">

<Editor Type="Autodesk.VaultToolkit.PropertyEditor.Editors.ValueListEditor" />

</Property>
<Property Name="Product Family" Required="true" DataSourceType="Expression"

DataSource="XmlQuery ({ProductData.DataSource}, //Data/ProductGroup[@Name="'{Product Group}']/ProductFamily/@Name)"

Target="UserDefinedProperties.Product Family">

<Editor Type="Autodesk.VaultToolkit.PropertyEditor.Editors.ValueListEditor"

</Property>
<Property Name="Product Model" Required="true" DataSourceType="Expression"

DataSource="XmlQuery ({ProductData.DataSource}, //Data/ProductGroup[@Name='{Product

Group}']/ProductFamily[@Name="'{Product Family}']/ProductModel/@Name)" Target="UserDefinedProperties.Product

Model">

<Editor Type="Autodesk.VaultToolkit.PropertyEditor.Editors.ValueListEditor" />

</Property>

And the used DataSource file looks like this:

<ProductGroup Name="Group 1">
<ProductFamily Name="Family 1A">
<ProductModel Name="Model 1Al" />
<ProductModel Name="Model 1A2" />
<ProductModel Name="Model 1A3" />
</ProductFamily>
<ProductFamily Name="Family 1B">
<ProductModel Name="Model 1B1" />
<ProductModel Name="Model 1B2" />
</ProductFamily>
<ProductFamily Name="Family 1C">
<ProductModel Name="Model 1C1" />
</ProductFamily>
</ProductGroup>
<ProductGroup Name="Group 2">
<ProductFamily Name="Family 2A">
<ProductModel Name="Model 2A1" />
<ProductModel Name="Model 2A2" />
</ProductFamily>
<ProductFamily Name="Family 2B">
<ProductModel Name="Model 2B1" />
</ProductFamily>
<ProductFamily Name="Family 2C">
<ProductModel Name="Model 2C1" />
<ProductModel Name="Model 2C2" />
</ProductFamily>
<ProductFamily Name="Family 2D">
<ProductModel Name="Model 2D1" />
<ProductModel Name="Model 2D2" />
</ProductFamily>
</ProductGroup>

19
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Inventor Parameter Example

For Inventor files it can be useful to get some information direct from the file (e.g. material, thickness). Therefor the property
management feature support all available parameter defined in the file. To extract this parameter it's required to use as
DataSourceType=Inventor.Parameter and as DataSource the name of the parameter from the Inventor file.

This can look like this:

<Property Name="Material Thickness" DataSourceType="Inventor.Parameter" DataSource="Thickness"
Target="UserDefinedProperties.Material Thickness"/>

Note:

e Inventor parameter especially thickness are used with property type number, if you configure the property in Vault,
please be aware of the correct types

{\ AUTODESK.
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Publish Jobs

The Vault standard functionality is to publish a visualization file (e.g. a *.dwf — file for Inventor - files) using the job server. The
standard doesn’t support any other file formats.

The Publish Jobs functionality allows you to create files in formats, like:

e  CATV5Product

e CATV5Part

e |IGES

o T

e PDF

e STEP

e  Flat Pattern DXF
o STL

The creation might be triggered manually or through a state change. You have some options concerning the resulting files:

e  Resulting file name patterns can make use of Vault — properties
e  Resulting files can be attached to the original file
e  Resulting files can be dropped in a specific folder

Configuration

All job handlers are registered in the Autodesk.VaultToolkit.Vault.JobHandler.vcet.config file. The file is
located under C:\ProgramData\Autodesk\Vault 2014\Extensions\Autodesk.VAO.JobHandler

During Enterprise Add-On for Autodesk Vault installation, it is recommended to stop the job processor service before installing
Enterprise Add-On for Autodesk Vault and to restart it once the installation is completed, this will ensure that all the changes
take effect properly.

The JobHandler element uses following syntax:

<setting key="JobType1" value="Class Name"/>

Following entries are in the default configuration file:

<setting key="JobTypel" value="Autodesk.VaultToolkit.Publish.CATV5Part"/>
<setting key="JobType2" value="Autodesk.VaultToolkit.Publish.CATV5Product"/>
<setting key="JobType3" value="Autodesk.VaultToolkit.Publish.IGES"/>

<setting key="JobTyped" value="Autodesk.VaultToolkit.Publish.JT"/>

<setting key="JobTypeb" value="Autodesk.VaultToolkit.Publish.PDF"/>

<setting key="JobTypeb6" value="Autodesk.VaultToolkit.Publish.STEP"/>

<setting key="JobType7" value="Autodesk.VaultToolkit.Publish.FlatPatternDXF"/>
<setting key="JobType8" value="Autodesk.VaultToolkit.Publish.STL"/>

Configuration of publish jobs

It is possible to specify default options for each supported file format. The configuration is via XML file which needs to be
imported into Vault.

A configuration template is stored in the following directory
C:\Program Files\Autodesk\VAO 2014\Configuration\Publish Jobs\JobConfiguration.xml.
If you edit configuration file in the location above, don't forget to import it using custom command (Tools = Enterprise Add

On - Settings... = Publish Jobs) which is available in Vault Explorer. This guarantees that same options will be available for all
users connected to same server and Vault database.
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Additional to the example configuration file the installer provide 3 new *.scr files and the PublishSettings.xml file to support the
usage of AutoCAD Core Console and printing of multiple layouts into on PDF. Therefor it's important to import the following

files into Vault and specify the location in the configuration file.

e  PublishConsolePDF.scr

e  PublishMultiPDF.scr

e  PublishPDF.scr

The PublishSettings.xml file can be saved in each local location. After the installation the file is saved in folder C: \Program
Files\Autodesk\VAO 2014\Configuration\Publish Jobs.

Table below contains detailed list of common options:

Option Name Default Value Description

UploadToVault true If true then output file is stored in Vault.

AttachToParentFile true If true then output files is attached to original input file.

HideAttachment false If true then attachment is hidden.

AttachAsVisualization false If true then attachment is added as visualization
attachment. If is true but there is more than one output
document then the behaviour is as if is false.

DestinationVaultPath (empty) If empty then file is stored in same location as input file. If

specified then file is stored in provided Vault location.

{e.g.: SNVisualizations/..)

OutputVaultFileName

{FileName}.ext

Expression which defines filename of output file. If empty
then name is same as original file.

OutputFileCategory

(empty)

Category name which will be automatically assigned to the
output file. If empty no category will be assigned.

OutputFileProperties

Designer|Part
Number|Category
Name=Comments

List of property names which should be copied from input
file to newly created output file. The vertical bar ()
character is used as separator between property names.

UDP’s can be listed / System Properties will be copied as
well (in this case the Mapping is “System Property’s
name=User Defined Property’s name”

CopyToOtherDestination false If true then file will be copied to other destination outside
of Vault.
DestinationPath path Path where file should be copied.

OutputFileName

{FileName}.ext

Expression which defines filename of output file. If empty
then name is same as original file.

The name can be different from Vault name.

SynchronizeProperties true If true a synchronize of properties are included in the job
UpdateRevisionBlock true If true an update of revision block are included in the job
UseLatestFileVersion false If true the latest version of the file is used when the job is

processed rather than the version of the file when the job
was put on the queue.

Following keywords can be used when specifying name of output file.

Keyword Description
FileName Filename of input file (without extension).
FileRevision File revision of input file.
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Keyword Description

FileMasterid Vault File Reference number

Any Vault Property If the Vault property value is empty “NA” will be used for the file naming

Following keywords can additionally be used when specifying DestinationVaultPath setting.

Keyword Description

WorkgroupDesc Workgroup Name

WorkgroupLabel Workgroup Label

Workgrouplid Workgroup Identificator
Note

e An example configuration file is included in the
C:\Program Files\Autodesk\VAO 2014\Configuration\Publish Jobs

e Common options can be overridden when job is initiated from Vault Explorer using Publish File, resp. Publish Folder
commands.

e  Only UDP's in bi-directional or Vault to File assignment can be used to update properties.

e AutoCAD can display additional dialog boxes when opening files (e.g. missing SHX files, opening DWG from non-
Autodesk application, DWG containing VBA macros). To guarantee correct processing on job processor it is important
to configure AutoCAD to suppress such dialogs. This must be done manually before using Job Processor.

e JobProcessor.exe must running for handling all Jobs

e  The manual Publish and the automatic execution of a specific job via LifeCycle status change will use the first
configuration. Therefor it is necessary to rename the Class names for Job type in the configuration file and in the
Autodesk.VaultToolkit.Vault.JobHandler.vcet.config if more than one job with different content
exist (see example in Usage Chapter for Publish Jobs)

e If custom job option "SynchronizeProperties" and/or "UpdateRevisionBlock" is set to "true", it is important to change
the C:\Program Files\Autodesk\Vault Professional 2014\Explorer\JobProcessor.exe.config file and comment the line
<gueueUpdateRevisionBlockJob extension=".idw" /> in level <syncPropertiesPostJobExtensions>; otherwise an
additional update revision block job will be added and failed as it is not possible to run a job on a non-tip version

Import Configuration

To import configuration use following steps:

1. Run Vault Explorer.

2. Go to Tools = Enterprise Add-On =» Settings.

3. In Settings dialog under tab Publish Jobs select Import configuration.
4. Select XML file for import.

Export Configuration

To export configuration use following steps:

Run Vault Explorer.

Go to Tools =» Enterprise Add-On =>» Settings.

In Settings dialog under tab Publish Jobs select Export configuration.
Enter name for XML file.

PwWhN =

Configuration of Publish Settings
The file PublishSettings.xml contains all possible sheet settings. Each format must be added within the following syntax.

<PublishSheetSettings>
<Scope>All</Scope>
<StyleSheet Name="acad.ctb" />
<PlotConfiguration Name="DWG To PDF.pc3" />
<MediaMappings>
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<MediaMapping
<MediaMapping
<MediaMapping
<MediaMapping
<MediaMapping
</MediaMappings>

Frame="AQ0"
Frame="A1"
Frame="A2"
Frame="A3"
Frame="A4"

</PublishSheetSettings>

Option Scope can be

Scope=Model: publishes only model space
Scope=Current: publishes only the current layout (either model or plot layout)
Scope=All: publishes all plot layout (no model space)

Vault Configuration

Media="TISO A0 (1189.00 x 841.00 MM)" />
Media="TSO Al (841.00 x 594.
Media="ISO A2 (594.00 x 420.
Media="TSO A3 (420.00 x 297.
Media="ISO A4 (210.00 x 297.

00 MM)" />
00 MM)" />
00 MM)" />
00 MM) "™ />

The job handler requires that Vault uses consistent working folder and project file for all clients:

E Working Folder Options

Workspace Folders

Client Working Folder:

$/Designs.ipj

() Allow clients to define waorking folder

@ Enforce consistent waorking folder for all clients

%USERPROFILE\Working),

Autodesk Inventor Project File for Vault Options
Enforce consistent project file for all clients

Default Inventor Project File:

LX)

-]

=]

oK

l ‘ Cancel ‘ |

Help |

Note

e During job processing files are downloaded from Vault to local workspace and overwrite existing files.
e The Client Working folder can also contain environment variable (%USERPROFILE%\Vault).

Lifecycle Event Jobs

It's possible to configure Vault to run publish job on lifecycle state change. The Vault SDK is required to enable this to work;
the LifecycleEventEditor is used to fulfil this functionality. The application is include in Vault SDK (under C:\Program Files
(x86) \Autodesk\Autodesk Vault 2014 SDK\util\LifecycleEventEditor).

Use following steps to add a Job Class Name to a LifeCycle status transition:

1. Run LifecycleEventEditor.

2. Llogin to Vault.
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LogIn @
AUTODESK" VAULT

Authentication: lVauIt Account VI
User Name: Administrator

Password:

Server: LOCALHOST

Vault: Vault - D

Automatically log in next session

OK l l Cancel l

<<

3. Select lifecycle definition and then select lifecycle state and transition where publish job should be triggered.
u:l Lifecycle Event Editor @
Actions
File, Folder and Custom Entity | [tem | Change Order
Lifecycle Definition: Flexible Release Process -
Lifecycle States: Lifecycle Transitions: Job types:
Work in Progress For Review -> Work in Progress
For Review->Released
Released For Review -> Quick-Change
Quick-Change For Review -> Obsolete
Obsolete For Review <- Work in Progress
For Review <- Released
For Review <- Quick-Change
For Review <- Obsolete
4.

Double click on empty space within Job types list. This displays Add Job Type dialog. Add the specific Class Name
which is also configured in the Autodesk.VaultToolkit.Vault.JobHandler.vcet.config file.

Add Job Type

Job Type:
Autodesk VaultToolkit Publish.PDF

Cancel I [ OK

5. Changes need to be saved using Actions > Commit Changes option.

Usage

In addition to automated file published on lifecycle state changes it's possible to schedule job manually from Vault Explorer.

Beside of Autodesk visualization files (*.dwf, *.dwg) it's possible to publish MS Office 2010 files as well. Therefore the MS Office
2010 package should be installed on the Job-Processor Machine.

File Publishing

1. Find document in Vault Explorer. Press right mouse button to display context menu.
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2.
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%, Catch Assembly.iam

|| Catch Agsembluidw |

ccory
7 Catch {2 Open

“ Comb View in Window...

Combd B4 Compare Drawings ...

47 Combd[§ Publish .. |

% Pad Lo/ Assian Trem._
Select Publish... The command displays following dialog. The Format dropdown-list contains all publishing formats
available for selected file.

B publish File ==

Selected file

Catch Assembly.idw

Format

PDF Inventor V] Options ...

[ ok || cancel |

The Format dropdown contains all publishing formats available for selected file type.

In case you did a multi selection of documents this list will only contain the common formats for all different file types
selected in the vault explorer window. To guarantee correct processing on job processor machine it's important to
configure AutoCAD to suppress such dialogs. In AutoCAD the best way to suppress theses dialogs is to do it manually and
select the same option as preferred choice, this should be done before using Job Processor.

The following cases should be avoided:

e Missing SHX file warning dialogs
e  Opening DWG from non-Autodesk application dialogs
e  Drawing Containing VBA macros dialogs

It is suggested that each document type be opened from Vault client before setting them up for correct processing on job
processor machine.

The select format is published using predefined configuration. However it's possible to override settings using Options
button. This displays following dialog.

1] Publish Options [

Save To Vault Options
Upload To Vault

Attach to Original File
I:‘ Hide Attachment

|| Attach As Visualization File

Vault Path
Filename
{FileName}.{Extension}

Category

Properties

Save To Other
|| Copy To Other Location

Destination Path

Filename

0K l I Cancel
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4. If necessary you can change the values in dialog to generate a different temporary result.

Close dialog using OK button.
Note: Next time the default settings from the DB will be used again.
5. The command will now check for the number of jobs to be created (multi select).

-

Publish File

|

I

'Q Mumber of jobs added to the queue: 1

6. Close Publish dialog using the OK button. This will add a new job into the job queue within vault.
You can use the Job Queue window to check if the job was processed / is processing / or is pending to be processed soon.

E Job Server Queue

b o e -

—_— —

-u.1.--- L

: Close | Queued After:

LJ_?."| > jRe—éuum.’t| =] Eemove| Reset to gueue | ﬁ | Take Site Ownership | i;l

Priority Status

publish format

Pending

Multiple Publish Formats for one File Type

The first thing is to add new Job Class Names to the Autodesk.VaultToolkit.Vault.JobHandler.vcet.config
file which is located under C: \ProgramData\Autodesk\Vault 2014\Extensions\Autodesk.VAO.JobHandler.

1.  Open the file in an text editor and add a new Class Name

<setting
<setting
<setting
<setting
<setting

<setting key="JobType8"
<setting key="JobType9" value="Autodesk.VaultToolkit.
</extension>
</connectivity.ExtensionSettings3>
</configuration>

key="JobType3"
key="JobTyped"
key="JobType5"
key="JobTypeb"
key="JobType7"

value="Autodesk.VaultToolkit.
value="Autodesk.VaultToolkit.
value="Autodesk.VaultToolkit.
value="Autodesk.VaultToolkit.
value="Autodesk.VaultToolkit.
value="Autodesk.VaultToolkit.

2. Restart the JobProcessor.exe to load the new defined jobs.

27

Description Submitted C
09/07/2013

Publish file (PDF Inventor): C...

When more than one publishing formats defined for the given file type the first definition will be used.

Therefore the recommendation is to create new Job Class Names defined in the
Autodesk.VaultToolkit.Vault.JobHandler.vcet.config file to be able to handle more than one

Publish.IGES"/>
Publish.JT"/>
Publish.PDF"/>
Publish.STEP"/>
Publish.FlatPatternDXF"/>
Publish.STL"/>
Publish.PDF.MultiLayout"/>
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[ « Job Types @1

Job Types

The following job types are processed by this Job
Processar.

Autodesk.VaultToolkit.Publish.PDF -
Autodesk.VaultToolkit Publish.STEP 3
Autodesk.VaultToolkit Publish.FlatPatternDXF
Autodesk VaultToolkit Publish.STL

Autodesk VaultToolkit Publish.PDF.MultiLayout
autodeskvault.dwf.createiam -

Close

3. Export the existing JobConfiguration from Vault Client and open the file in a text editor
4. Copy and reuse the existing PDF publish format and change the JobHandlerClass to the new Class Name. Change the
Name to be able to identify the format in the publish function in Vault client

<Publisher Name="PDF AutoCAD Multi Layout"
JobHandlerClass="Autodesk.VaultToolkit.Publish.PDF.MultiLayout"
SupportedFileExtensions="dwg"
OutputExtension="pdf"
PublisherType="Autodesk.VaultToolkit.Vault.Autocad.AutocadCoreConsolePublisher,
Autodesk.VaultToolkit.Vault.JobHandler">

5. Change the Option AcadScriptTemplate to the PublishMultiPDF.scr file, was uploaded to Vault in chapter
Configuration of publish jobs

<Option Name="AcadScriptTemplate" Value="$/Configuration Files/PublishMultiPDF.scr" />

6. Change the other options as needed

7. Open the PublishMultiPDF.scr in a text editor (if the file is already checked in Vault, check the file out to be able to change
something)

8. Add/Change the path to the file

9. Import back the new Job configuration xml file “PublishSettings.xml|” (per default the file is located in the VAO installation
path \Configuration\Publish Jobs)

10. Open the file PublishSettings.xml and add additional/missing sheet settings for your layouts

11. Save both files; Check in the PublishMultiPDF.scr into Vault

12. To include the new Job definition in a LifeCycle status change, open the SDK LifeCycle Event Editor as described in chapter
Lifecycle Event Jobs and add the new JobHandlerClass to the required transition

13. rAfter import the new configuration the new job is also availabl1e via publish function

% Publish File

Selected file
ZWH1.dwg

Format

(PDF AutoCAD ) | opiions.. |
PDF AutoCAD

PDF AutoCAD Multi Layout

PDF Inventor ‘ Cancel

Cancel Condition for Jobs

The Job Handler provides an option where a specific defined condition will cancel the job. The condition can be set for each
publish format definition and check the value of defined Vault properties. System and user defined properties are supported.
The condition can contain one or more criteria and can combined with “and” and “or”.

<Option Name="Condition" Value="Name = &quot;Created By&quot; and Value.ToString() = &quot;Administrator&quot;" />

If the condition is true, the job will be cancel. In the example above does it mean, if the Administrator was creating a file and
start a publish job, the job will be added to the job queue. No file will be created and no application was started to finish such
job.

{\ AUTODESK.
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Show “positive” failed jobs in the Queue

If the Administrator will see the result of a failed job, the option FlagError must set to True. If this is the case, the job
queue will let the job as failed with a message about the failure. Otherwise the job will be marked in the log file as finished
successfully without staying in the queue.

Details
Job Type: AutodeskVaultToolkitPublish.PDF Description: Publish file (PDF AutoCAD): ZWH1.dwg
Submitted By: Administrator Status: Error
Submitted Date: 09/07/2013 16:31:25 Results:  Error during job processing,File cannot be

published due to configured property criteria

Folder Publishing
Similar to file publishing it's possible to publish selected folder.

1. Locate folder in Vault Explorer. Press right mouse button to display context menu.

] Assembiie =
HED EX] Mew Folder...

7 Ind Ve [ sy (B

=] Padl e

71 Shee [Ll Add Files...

Drawing
3 Clone Structure ...
Infrastr %

Librarieq P _Publish ..

2. Select Publish. The command displays dialog below. The dialog displays list of supported file formats and for each file
format list of available formats for publishing.

{\ AUTODESK.
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o] Publish Folder -

=Cowa
~|__|PDF AutoCAD
I (] PDF AutoCAD Multi Layout
|__|PDF Inventor
IDW
---|:|PDF Inventor
IPT
L |STEP
L |IGES
1T i
| -[[|CATIAVS Part I
Ll STL
[l .| |Flat Pattern DXF
= 1AM
] - |STEP
f -[CIGES
Ll -[CT
[ ]CATIA VS Product '
I -[C]sTL 1
| \
||
|
i Process Sub Folders I
[ OK ] l Cancel l
| : J

Select desired format for publishing. It is possible to select multiple formats.

Files will be publisher using predefined options. It's possible to override settings using Options button. Click on button to

display following dialog.

- —_—
[ Publish Option

S

Save To Vault Options
Upload To Vault

Attach to Original File
[] Hide Attachment
|| Attach As Visualization File

| Vault Path
Filename
{FileName}.{Extension}

Category

Properties

Save To Other
l || Copy To Other Location

Destination Path

Filename

OK ] [ Cancel
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Set options as needed. Close dialog using OK button. Close Publish Folder dialog using OK button. The command will
check for suitable files and report number of created jobs.

E Publish Folder u]
il N

=1 DWG
[ |PDF AutoCAD
[ |PDF AutoCAD Multi Layout
[ |PDF Inventar
=1« IDW
: [V|PDF Inventor

Publish Folder

|@ Mumber of jobs added to the queue: 3

D Priority Status Description Submitted Date Submitted By
3 5142 1 Pending Publish file (PDF Inventor): Pad Lockidw 10/07/2013 09:13:16 Administrator
143 1 Pending Publish file (PDF Inventor): Combo Assembly.idw  |10/07/2013 09:13:16 Administrator
144 1 Pending Publish file (PDF Inventor): Catch Assembly.idw 10/07/2013 09:13:16 Administrator
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Clone Struc

ture

While in the standard functionality of Vault you can only move folders in Vault and no copy is possible, this functionality offers
you a way to copy folders selecting any folder.

With the Clone Structure functionality:

e  Select a folder and copy it
e  You can define new folder name, new folder location, and other options

e  Properties and Permissions can be considered as well

Configuration

The Clone Structure command supports any folder structure including project structure used by AutoCAD Civil3D. In this case
the structure contains additional files required by Civil3D —i.e. PointsGeometry.db.

The list of such files can be defined in the file named IncludedProjectFiles.xml. The file is located in
C:\ProgramData\Autodesk\Vault 2014\Extensions\Autodesk.VAO.

Element Name Attribute Name Description
IncludedFile One or more entries which specify which files has to be
copied when copying folder structure.
Path Relative path (including filename) of the file.
Note

e  The files specified in the IncludedProjectFiles.xml are handled without any references.
e  The Vault Setting for Files to “Enforce Unique File Names” will cause that the specified Civil 3D files will not be copied.

E Vault Settings

=X=)

0

Files

Visualization | Behaviors | [tems | Change Ordersl Custom Object5|

ptions

Enforce Unique File Names

Usage

[] Disable Check In of Design Files

| Find Duplicates |

1. Selected folder to copy in the Navigation Pane. Press right mouse button to display context menu.

2. From context menu select Clone Structure command.

28] Proje

B4 My Sear L New Folder..
[} Add Files..
‘% Clone Structure ...
R puhlich

3. The command will display following dialog. Enter name of new folder in Close as text box. It's possible to specify
destination location in To text box.

32
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5.

ﬁ Clone Structure

Source Path
$/Projects

Clone As
Projects - Copy

To
%

Destination Path
$/Projects - Copy

Copy Permissions
Copy Properties

Lo ]

Cancel

|

-

You can select destination folder using ... button.

@ Select Folder

- )

BE’E‘ %
F-E7 Configuration Files
-F1 Designs
51-F1 Drawing compare
-F7 Infrastructure
G- Libraries
@1F7 Object Links
& o e
#-E3 ProjectA
& E7 Project B
& F7 Project C
B ProjectD

e

|

The Copy Permissions check box allows copy folder permissions to new folders. The Copy Properties check box allows

copy properties from source folder to new folder.

Note

33

e The clone structure utility copies the folder/project structure only. It does not copy the files.
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Drawing Compare

The Compare Drawings command integrates drawings comparison of Autodesk Design Review into Vault command. The
command lets you compare two drawings or two different revisions/versions of same drawing.

Configuration

Note: The Drawing Compare function is only working on a 32 bit machine. No configuration is required.

Usage
Please follow these instructions to use the drawing compare functionality:

1. Select a document in Vault Explorer. Press right mouse button to display context menu.

As alternate option you can seelct two different files in navigation pane. It's also possible to select two different file
versions on History tab of preview pane.

2. From context menu select Compare Drawings command. The command displays following dialog.
@ Drawing Cornpare @

1stFile  ZwH1.dwg 2ndFile  2wH1.dwg
Rewizion |4 - Revigion |B hd
Additions - Deletions

Sk RE = - 1of2 b O
Markups E] PEIE el 1 "-;Iw ['H |
E| & 2wH1+odel -_;[ 15505060210,
: [
5| £ Deletions fram comparis... ;
RIS '
R1.
20 (80140 1q
21.8215 40 440

4 T 3 i |

| Compare || Cloge |

3. The Revision dropdown below 1° File shows list of available revision for first file. The Revision dropdown under 2" File
shows list of available revisions for second file.

4. Click on Compare button. The graphical comparison is displayed in the dialog.

5. Use Additions/Deletions buttons to change color for additions and deletions.

Note

e  Only Revisions where DWF preview is available are listed in dropdown.
e  This feature is not working on a 64 bit maschine

{\ AUTODESK.

34



E-Mail Notification
The E-Mail Notification in the standard Vault is related to ECO’s and ERP.
This functionality of the VAO allows an E-Mail being sent to Vault Users triggered by a specified action (state change).

Generally we have two options:
e  Recipient of E-Mail is the user which executed the last state change

e  Recipient of E-Mail will be selected from a list

Further user interaction (e.g. confirmation of the E-Mail) is only needed when selecting the users from a list. In other cases
there is no User interaction necessary.

Configuration

The configuration for the email notification is defined using XML file. The import and export of configurations, as well the
creation of a template configuration file can be done from the Settings Ul.

[¥3 Vault Add On Settings 53

| ObjectCIassiﬁcaﬂon| E-Mail Motification | Four Eyes Checkl Property Management | Publish Jobs|

Import E-Mail Netification configuration from a XML file into Vault

| Import Configuration |

Export E-Mail Motification configuration from Vault to a XML file.

| Export Configuration |

oK l ‘ Cancel
Following parameters must be defined in the XML file:
Element Name Attribute Name Description
LifeCycleStateTransition One or many entries which specify how the email
notification engine has to behave.

RecipientGroups A list of Vault user groups. If UserChooseRecipients is set
to ‘false’, this will be used to restrict the list of possible
recipients.

LifeCycleStateDefinitionName | The name of the life cycle state definition which is used by
the files.

LifeCycleStateNameFrom The name of the life cycle state from which the files are

being changed from.

LifeCycleStateNameTo The name of the life cycle state to which the files are being
changed to.

EmailSubject The subject which will be written in the email.

EmailBody The content which will be written in the email.

UserChooseRecipients ‘true’ if the user has to choose from a list of possible

recipients, ‘false’ if the application has to determine the
recipient automatically from the previous life cycle state
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Element Name Attribute Name Description

change.
SmtpSettings Defines the configuration for the used SMTP server.
Host The name of the Host, e.g. Smtp.gmail.com.
Port The port which is used to connect to the SMTP server, e.g.
587.
EnableSsl ‘true’ if the SMTP uses SSL, otherwise ‘false’.
Login The login name for the SMTP server, e.q.
myadress@gmail.com.
Password The password for the above specified login.
VaultAdminUsername The username of a Vault administrator user. This is being

used to get the users and groups.

VaultAdminPassword The password for the above specified Vault administrator
user.

The email subject and —body configuration can include placeholders which will be replaced by real values before an email is
being sent out. Valid placeholders are:

Placeholder Description
{Username} The First- and Last name of the user who did the life cycle state change.
{LifeCycleStateNameTo} The name of the life cycle state to which the file(s) were changed.
{Files} The name(s) of the file(s) which were affected.
{Vault} The name of the Vault instance.

Note

®  Anexample XML File is included in
C:\Program Files\Autodesk\VAO 2014\Configuration\Email Notification

e If UserChooseRecipients is set to True, but no active users exist to display, the Administrator defined in the
configuration will be displayed instead.

e If UserChooseRecipients is set to False and the user to which the email should be sent is not active, the email will be
sent to the Administrator defined in the configuration instead.

e Todisplay each filename in a separate line the user should note that by default Outlook might remove newline
characters which it considers unnecessary. The user has an option to restore the remove characters though.

Usage
The email notification works in two different ways, depending on how it has been configured:

e Send email automatically to the user who made the previous life cycle state change.
There's no interaction with the user required for this. Vault automatically sends the email after a file's life cycles state
change has been completed.

e Let the user select the recipients to which the email will be sent

1. After a file’s life cycle state change has been completed, a screen will be shown the recipients.
2. The user has to specify one or many email recipients and clicks Ok.
3. The email is being sent to the selected recipients

Note

e Aninformation log entry will be created for each sent email notification in the Windows Event log.
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Object Classification

The edition of properties can be — especially when editing various wide - spread properties — a time intensive task.

This functionality can be used for visually joining together properties which have to be edited or reviewed. Therefore the
edition or reviewing is faster and more secure.

The user can see a new tab in the Vault preview pane, where he can select the schema, which defines the properties to be
shown.

This functionality is suitable for items and documents, once an item or document is selected.

Configuration

The configuration of the object classification rules is stored in an XML file. The Classification XML can also be generated
manually. A template can be found in the installation path C:\Program Files\Autodesk\VAO
2014\Configuration\Classification.

The vault properties used for the DOCUMENT or/and ITEM classification need to be as a minimum
member of the Vault “File” or “Item” category. They do not need to be (but can be) part of the categories definition in Vault.

Key field description of the Classification XML:

Element Name Attribute Name Description

ClassificationSchemaGroup Defines one Classification Schema Group.
Defined ClassificationSchemaGroup can have 1 or more
ClassificationSchemas.

PropertyName Name of Vault property where classification is stored.
Category Either File or Item.
ClassificationSchema The ClassificationSchema can contain one or more Properties.
This Tag contains the real Class definition for the UL.
Name Name of schema. Must be unique within one schema group.
Category

The category has to be one of the categories specified in vault.
Multiple category names can be specified using vertical bar as

separator, for example: Engineering|Documentation

ClassificationProperty One Property Definition to be used by the Class defined by the
ClassificationSchema tag. (no System property!)
PropertyName Name of Vault property.
Mandatory Indicates if property is mandatory or not (true/false).
DefaultValue Default property value for given schema. This is optional.
Description Description of the property for given schema.

The XML file must be configured to fit the business requirement and then imported in to Vault prior usage of the add-in
functionality. The XML file can be imported using Autodesk Vault 2014 client.

Tools = Enterprise Add On - Settings... = Tab Object Classification = Import Configuration
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¥4 Vault Add On Settings

=

Object Classification | E-Mail Motification | Four Eyes Check | Property Management | Publish Jobs|

Import Object Classification configuration from a XML file into Vault

l Import Configuration I

Export Object Classification configuration from Vault to a XML file.
l Export Configuration I

OK l [ Cancel

Note:

e  Vault Client must be restarted after importing an object classification xml configuration file.

e The xml file needs to be a UTF-8 encoded document when you plan to use “Special Characters” such as <, * ' ,a, A,
..... > in the "Description” attribute. Only in this case Vault will display the characters correct as it is a UniCode
application.

e  System properties are not supported by the classification because it is not possible to write values to them

e User Defined properties are only supported.

Usage

The custom Classification tab is available for files and items. The Schema dropdown contains list of available schemas.

| H\stmyl Uses |Where Used | Change Order | Preview| Classification
Schema [Emgineermg v]
Property Description Walue
Group Iy nice group
1 Header Z9H Header
Cuyrier Quwner of the object Teamn 1
Update ] [ Remowe

The grid displays list of properties associated to the schema:

e  Mandatory properties are displayed using bold font.
e  Properties where corresponding Vault property is missing are displayed in grey color.
e If value of mandatory property is not provided then similar error will be displayed during update.

Yault Taalkit Error @

-
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e  The columns are sortable.
e It's possible to set filtering based on the values in selected column.
e  The Schema dropdown and Update buttons are disable if current object can't be edited.

The steps to use the object classification utility are as follows:

1. Locate file in the file list.

2. Go to Classification tab.

3. Set property values.

4. Press Update to save changes.
Note

39

e By using the “Remove” button it is possible to remove classification properties from a document.
This will remove all properties associated to currently assigned class as long as they are not associated to the current
object by means of the Category of Vault. However the “Class” attribute will be deleted from the object to
successfully detach the class. When you want to reassign a class later on the property “Class” will be reassigned again
automatically.
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Content Center Part Generator
The Content Center Part allows the creation of CC-Parts and saves them into the Working Directory.

This can be used when the CC-Parts has been updated by the CC-Administrator. Instead of the updated parts being selected
one by one by the design engineer, this task can be separated (by time and person) and done by another person at another
time (e.g. starting during the night).

It allows the creation of the CC Parts in a stack — the CC Parts are selected and processed (downloaded) in order to be used
directly.

For the CC Part Generator it makes no difference if your CC is locally stored or located inside the vault. If you want to upload
parts into the CC you can use the Autoloader or Inventor Task Scheduler.

Configuration

There is no configuration needed. The application is located in the installation path of VAO 2014 C:\Program
Files\Autodesk\VAO 2014.

Usage

The Inventor Content Center Part Generator application allows creation of selected content center parts before these are used
during modelling. This saves some time for designers as they can use already created parts instead of creating them during
design process.

Generating content parts

1. Start Autodesk Inventor 2014
2. Start ContentGenerator.exe. This will display the main dialog.

% Autodesk Inventor Content Generator @1

Location
C:\Users\ Documents\Inventor\Content Center Files\R2014\

Library

| Select... \

Search P X

Family Name Folder Member Count Status

¥| Overwrite Existing Instance
V| Skip Suppressed Rows
Restart Inventor after 100 instances

Stop on error

Generate ‘ [ Close

3. Click on Select button to choose library name.
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Libraries
Library
Inventor ISO
Inventor Feature

Inventor ANSI
Inventor DIN

Ok | [ Cancel |

The family list shows list of available families.

Search e

Family Name Folder Member Court State =
[] DIN 1024 DIN 1024 15 L4
[T] DIN 1025-1 DIN 1025 20

[] DIN 10252 IPB DIM 1025 IPE 24

[] DIN 1025-3 IPBI DIM 1025 IPEI 24

[] DIN 1025-4 IPBv DIN 1025 IPBv 25

[] DIN 10255 IPE DIN 1025 IPE 18

[[] DIN 1026 U DIN 1026 U 24

[C] DIN 1027 Z DIN 1027 £ 1

[C] DIN 124 A DIN 124 A 254

[l DIN124B DIN 124 B 254 -

4|

I

Use checkbox on the left side to select/unselect family. As an alternative you can use context menu and use Select All/Clear
All option to select/unselect family.
If desired you can activate the “Skipped Supressed Rows” option box. In case of activation, the suppression of rows will be

honoured by the tool.

Click on Generate button to start creation of the content center parts. The progress of creation will be indicated in

separate window.

Detailed progress is displayed in the progress window.
[27.07.2012 14:17:50] Loading library 'Inventor ISO'. Please, be patient - this could take some time.

[27.07.2012 14:19:47] Loading complete.
[27.07.2012 14:21:24] Family member ISO 7719/10. Saved as D:\02 Arbeitsordner\Vault Training\08 Content
Centefen-US\ISO 7719S0 7719 - M5.ipt
[27.07.2012 14:21:25] Family member ISO 7719/20. Saved as D:\02 Arbeitsordner\Vault Training\08 Content
Centerlen-US\ISO 771050 7719 - M6.ipt
[27.07.2012 14:21:26] Family member ISO 7719/30. Saved as D:\02 Arbeitsordner\Vault Training\08 Content
Centenen-US\SO 7719IS0 7719 - ME.ipt
[27.07.2012 14:21:26] Family member ISO 7719/40. Saved as D:\02 Arbeitsordner\Vault Training\08 Content
Centefen-US\ISO 7719S0 7719 - M10.ipt
[27.07.2012 14:21:27] Family member ISO 7719/50. Saved as D:\02 Arbeitsordner\Vault Training\08 Content
Centerlen-US\ISO 771R0IS0 7719 - M12.ipt

The Status Column displays result of processing. If there was an error during processing then status is displayed using red

color.

Member Count

15
20
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Search functionality

1. Type text into Search box.

Search |57 | | X

2. Click on Search button. The items containing given text will be highlighted in blue color.
Search 57 2| 10f9
Famiby Mame Folder

[] DIN 2566 Flange Type C-PN ... DIN 2566 C - PN 10
[] DIM 2566 Flange Type C-FN ... DIN 2566 C-PN 16
[] DIN 2573 Plain Face Flangefo... DIN 2573 PN 6{2)
[] DIN 2573 Plain Face Flangefo... DIM 2573 PN &{1)
[] DIM 2573 Plain Face Flangefo... DIM 2573 PN &4)
[] DIM 2573 Plain Face Flange fo... DIM 2573 PN &(3)
[] DIN 2576 Slip-On Flange for W... DIN 2576 PN 10(2)

3. The search button allows you to cycle in the selection. The current item will be highlighted in pink color.
4. Search can be cancelled using Cancel Search button.

Log window

1. Use Save button to save content of the log window into text file.
2. Use Clear button to clear content of the log window.

=

“Caortent Center Files®R2011%en-USHDIN 1025 IPBMDIN 1025 - IPB 700-1.ipt -
[5/4/2011 11:00:32 AM] Family member DIM 1025-2 IPB/220. Saved as C:\Users" “Documentsnventor
“Caontent Center Files R2011%en-USADIN 1025 IPENDIM 1025 - IPB B00-1.ipt

[6/4/2017 11:00:33 AM] Famity member DIM 1025-2 IPB/230. Saved as C:\Users' «DocumentsInventor
“Content Center Files®R2011%en-USHDIN 1025 IPENDIM 1025 - IPB S00-1 ipt

[5/4/2011 11:00:33 AM] Famity member DIN 1025-2 IPB/240. Saved as C:\Users' «DocumentsInventor
“Cartent Center Files'R207 1%en-USWDIMN 1025 IPBADIM 1025 - IPE 10001 ipt

i

1

Note

e If the option "Restart Inventor after XX instances" is activated in the Content Center Generator, it is required to
manually login to Vault every time Inventor restarts. The alternative to this is to change to a local Inventor project.
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Four Eyes Check

This functionality is used for supporting security measures (another user than originator must check / approve).

The check is applied during a state change on a document. It contains a control whether the current user is the same user who
has executed the previous state change. It contains two parts:

e  Pre Check
o  The state change must be defined (lifecycle name including from state and to state)
o  The pre-check contains several conditions at two different levels
o Level of the selected document
=  File extension
=  Property condition
o Level of the related documents (only first level documents)
= File extension
= Property condition
o Please have a look at the flow chart to determine the circumstances which have to be met by the Pre Check in
order to be successful.
e  User Check
o  After a successful Pre Check the User Check will be done.
Current User will be compared with the previous User
Previous User: the user who has changed the previous state to the current state
The state change will be cancelled when Current User and Previous User are equal. In other words: The two users
must be different.

o O O

If the Pre Check wasn't successful the user check won't be executed, and therefore the state change won't be cancelled under
any circumstances.

So in other words: As a default, there is no check — or the check defaults to true.

Configuration

The configuration for the four eyes check is defined by a specified XML file. The import and export of configurations, as well as
the creation of a template configuration file can be done from the Settings Ul of the Enterprise Add-On for Autodesk Vault
within the Vault Explorer.

[¥3 Vault Add On Settings (&3]

| Object Classification | E-Mail Motification | Four Eyes Check |Property Management | Publish Jobs|

Import Four Eyes Check configuration from a XML file into Vault

I Import Configuration I

Export Four Eyes Check configuration from Vault to a XML file.

I Export Configuration I

OK l l Cancel

Following parameters will have to be defined in the XML file to make it work:

{\ AUTODESK.

43



Element Name Attribute Name Description

FourEyesCheck One or many entries which specify for which life cycle
state transitions a 4eyes check have to be executed.
LifeCycleStateDefinitionName The name of the life cycle state definition.
LifeCycleStateNameFrom The name of the life cycle state from which the files are

being changed from.

LifeCycleStateNameTo The name of the life cycle state to which the files are
being changed to.

InformationMessage The message which is shown to the user if a four eyes
check failed.

FileTypeRestrictionExtensions Lists of file extensions for which the 4eyes check apply.
The extensions are separated by a “|" character (e.g.
“idw|dwg")

PropertyCheck A LINQ query expression which will be executed on the

file properties. The 4eyes check will only be executed, if
the file matches the property check expression. The
PropertyCheck will only be executed if no FirstLevelCheck
is specified.

FirstLevelCheck FirstLevelTypeRestrictionExtension A list of file extensions for associated files (only first
level). The 4eyes check will only be executed if one of the
associated files is of the specified type. The extensions
are separated by a “|" character (e.g. “idw|dwg"). If a
FirstLevelPropertyCheck should be executed for any type

of file, use a “*" character.
FirstLevelPropertyCheck A LINQ query expression which will be executed on the

associated first level file properties with above specified
extensions. The 4eyes check will only be executed if a file
matches the property check expression.

The application will compare the name of the VaultUser which did the LifeCycle change prior to the current state change with
the current VaultUser login.

In the case that they are the same the system will issue an exception and a message box will be displayed.

The workflow change process will be stopped and the user will need to change to a different VaultUser to change the state
after checking the documents.

However the application of the 4 Eyes Check can be bound to a number of pre-conditions:

e LifeCycleStateDefinitionName

e  State From & State To (Transition to be observed)

e  FileTypeRestrictionExtensions (Which File Type will qualify for the check)

e  PropertyCheck (Check a Property Value to match)

e  FirstLevelTypeRestrictionExtension (Check if the Content of the drawing is IPT/IAM/...)
e  FirstLevelPropertyCheck (Check a Property Value to match)

With this pre-condition you can position the check to the absolutely needed objects in Vault when changing their sate. Multiple
configurations (one per LifeCycleStateDefinitionName) are supported.

This function assumes the enforcement of a workflow definition native to the customer’'s current environment and legal
requirements by government or I1SO regulations.

LINQ expression

A LINQ query expression can execute checks on the following objects:
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Keyword

Description

Name The name of the property (type: string).

Value The value of the property (type: object).

PropDef The property definition object (see Webservice documentation)
Propinst The property instance object (see Webservice documentation)

An example expression could look like this:

Name = "Created By" and Value.ToString() = "Administrator"

Note:

e for now an expression has to be defined for each user

Start check

. Yes File type
Rule exists? restriction
Gtate specified?
definition No
d ]
and names) Ves
No File type as specified?
Mo es
First level ched
specified?
Mo First level as specified”
o= v First level
N & property chedd
specified?
Mg
First level property as
specified?
Mg
Property chedk
specified? es
Mo
Yes
Property as
specified?
Mo es
Is itsame wser?
Cancel state change
®
Chedk
finished

Figure 1: Act Four Eyes Check
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Usage

Based on a configuration that does not allow that a user can release a file and if he has created the file, the following message

would appear.

-
& Restrictions Found

)

Restrictions

9% Operation cannot continue because an extension raised restrictions.
(\u, Do you want to continue?

Print Preview

Affected Object

Catch Body_0l.idw

7 Restriction

Autodesk VAQ.FourEyesCheck: The creator is not
allowed to release a file.

| Yes | ‘ No ‘ [ Details <<

46
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VGet

A command line interface based functionality which enables users to retrieve files or folders from Vault and download them to
the local file system, to specific files or folders.

Configuration
There are two main actions:
e  Synchronize folder structure (no file download, optionally including all files in the folder)

e Synchronize file(s). This will create the folder structure as needed.

In a command window, typing the VGet.exe filename will display the syntax:

BN Administrator: C\WINDOWS\system32\cmd.exe o || = | &8

C:\Program Files\Autodesk\UAD 2014>UGet.exe
Usage: UGET [-s sru] [-db dbase] [-u user] [-p pwd] [-a Vault] [-t] [-r] [-f] <-sr source> [-tg target] [-x filter]
Name of server (default = localhost).
Name of database (default = Uault).
UserName for access to database (default = Administrator).
Password for access to database (default = empty password).
Authentication Type - Windows or Vault (default = Vault).
Only syncronize folder structure.

Recursiv syncronization.

Force refresh/sync.
-sr Full Vault folder and (optionally) file path.
-tg Local target path.
=X Include file ending filter (e.g. dwg;dwf).

:\Program Files\Autodesk\UAD 2014>

Parameter Description Optional
-a <authentication> 2 possible values windows or vault N
-U <user name> Vault user to be used to connect and get files/folders from Vault N
-p <password> Vault password to be used in conjunction with the above user name N
-5 <server> Server with Vault (Publisher server, in case of replicated systems) N
-db <database> Vault database to connect to N
<option> -t if a folder is specified; only the structure will be synchronized (not the files). | Y

Ignored when a single file is specified.

-r recursively get files is a folder is specified as a source. Ignored when a single
file is specified in <source> (default is not recursive)

-f force the refresh/sync operation (default is N: file is synchronized only if the
target file is different)

-Sr <source> Full vault path to the file to be synchronized or N

Full folder path to be synchronized

-tg [target] If a local path is specified, VGET will automatically try to download the files | Y
and/or folders to a target location. By default, if a file already exists, the file is
replaced only if the source file is different from the target file.

-x [filter] A file extension which is used when synchronizing folder structure. Not used if a | Y
file is specified as a source.

Usage

Please find below some examples for the usage of the tool.
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Sync folder structure (no files)

vget -u Administrator -p test —-db vault -t -sr $/prj001/cooker/modell/

In this case all files will be copied from the source vault folder to the local workspace.

vget -u Administrator —-p test -db vault -t $/prj00l1/cooker/modell/ -tg :\mycfg\

In this case the tool copied all files to the target folder.

Sync folder structure (including files)

vget -u Administrator -p test -db vault -sr $/prj001/cooker/modell/
vget -u Administrator -p test -db wvault -sr $/prj001/cooker/modell/ -tg f:\mycfg\
dwg;dxf

Sync individual files

vget -u Administrator -p test —-db vault -sr $/prj001/cooker/modell/best.dwg
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Vault User Accounts

This functionality belongs to the administrative tasks and is only available through a command line interface (cmd.exe) on your
computer.

It is used in order to import users and groups from a file. In this file the name of the user together with other information about
the user (roles, vaults and groups) has to be provided. This reduces the effort when creating user in a new Vault.

Configuration

This command line utility (VaultUserAccounts.exe) is located in the C:\Program Files\Autodesk\VAO 2014
directory.

In a command window, typing the VaultUserAccounts.exe filename will display the syntax:

BN Administrator: CA\WINDOWS\system32\cmd.exe o || B | &3

C:\Program Files\Autodesk\UAD 2014>UaultUserAccounts.exe
UaultUserAccounts v3.0.0.0 - imports/exports ADMS user accounts
Copyright (c¢) 2012 Autodesk, Inc. All rights reserved.

Usage: VaultUserAccounts [-u username] [-p password] [-s server] [-a authenticationType] [-g] IMPORT|EXPORT filename
-u UserName for access to database (default = Administrator).
-p Password for access to database (default = empty password).
-5 Name of server (default = localhost).
-a Authentication Type - Windows or Vault (default = UVault).

-g Exports group information instead of user user information.
-e Encoding. Provide either codepage or name. (default = UTF-8).
IMPORT IEXPORT Action type

filename C5U File which is used to write or read user information.

Examples:
UVaultUserAccounts -U Joe -P 123Password -$ VaultServer -A Vault -e UTF-8 EXPORT users.txt
VaultUserAccounts -5 UaultServer -A Windows EXPORT users.txt

C:\Program Files\Autodesk\UAD 2014>

Parameter Switch Description

Authentication Type | -a 2 possible values windows or vault

User -u Vault user to be used to connect and get files/folders from Vault

Password P Vault password to be used in conjunction with the above user name

Server =S Server with Vault (Publisher server, in case of replicated systems)

User Option -g Exports / Imports group information

IMPORT|EXPORT Set the action type to import or export the information

Filename CSV file which is used to write or read user / group information
Usage

This utility allows to export and import user and group definitions, greatly speeding up the creation and configuration of Vault
accounts when many users and groups are required by the customer.

This is a command line utility, and reads from/writes to a CSV file.

As best practice you should export your current user and group list from Vault to view the correct syntax of the CSV file, and
then adding into this your new user accounts either by typing, or adding in an export from Windows security lists, MS-Outlook
Contacts, or similar.

It is a simple syntax, even allowing for the type of user account to be exported/imported with the —A “AuthenticationType”
parameter.

-A vault means Vault created user accounts will be exported/imported

-A windows means that windows AD user accounts will be exported/imported
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Export user accounts

VaultUserAccounts -u Administrator -s localhost -a Vault EXPORT "C:\Temp\Users.csv"

C:\Program Files\Autodesk\UAD 2014>VaultUserfAccounts -u Administrator -s localhost -a Vault EXPORT “C:\Temp\Users.csu”
UaultUserAccounts v3.0.0.0 - imports/exports ADMS user accounts
Copyright (c) 2012 Autodesk, Inc. All rights reserved.

user ‘Project Manager 1°
user ‘Project Manager 2'
user ‘Project Manager 3'
user ‘Project User 1°

user ‘Project User 2'
user ‘Project User
user ‘Project User
user ‘Project User

2
3
4
5

C:\Program Files‘\Autodesk\UAD 2014>_

Note

e Itis easier to use the tool by creating a batch file (e.g. exportuser.cmd) with the syntax:
VaultUserAccounts.exe —-u administrator -p “” -s localhost —-a Vault EXPORT
“C:\Temp\users.csv”

e That the —A parameter is set to export VAULT defined user accounts. To export Active Domain enabled vault
accounts, the —A parameter would be set to “windows” as per the syntax description above. If the —A parameter is
set to “windows”; there is no need to use the parameter —u and —p.

e Import only if the user list contains exclusive vault users or exclusive windows user; do not use a user list with mixed
user accounts!

e To create the Domain User accounts the command passed to the VAO must contain a Domain User Account that
is in the Administrator Role within the Vault.

We have exported to a CSV file called “Users.csv” which looks like this:

A B C D E F G H |
1 FirstName LastName Username Email Password Role Vault Group Enable
2 Project Manager 1 Project.Manager.1@company.com Project 1 1
3 Project Manager 2 Project.Manager.2 @company.com Project 2 1
4 Project Manager 3 Project.Manager.3@ company.com Project 3 1
5 Project User 1 Project.User.1@company.com Project 1 1
6 Project User 2 Project.User.2@company.com Project 2 1
7 Project User 3 Project.User.3@company.com Project 3 1
8 Project User 4 Project.User.4@company.com 1
9 Project User 5 Project.User.5@company.com 1

Columns A-E define the users “firstname”, “lastname”, “username”, “email address”, and “password”; as you would normally
create a new Vault user.

Column F contains ALL the roles that this user should have, concatenated into one string and separated by a semi-colon for
each role.

These must be exactly as the descriptions in Vault, hence the recommendation to always start with an export of your current
user list from Vault; then it easier to cut and paste required roles for new users within MS-Excel.

Column G contains all the vaults that this user should be assigned to, again semi-colon separated.
Column H shows which groups this user should be assigned to.

Column I is set to “1” for all user so that they are enabled.

Once you have made your manual changes to this CSV file, save it, and re-import with the syntax like:

VaultUserAccounts -u Administrator -s localhost -a Vault IMPORT "C:\Temp\Users.csv"
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& Administrator: CAWINDOWS\system32\cmd.exe | = | (2 |-

m »

C:\Program Files\Autodesk\UAD 2014>VaultUserAccounts -u Administrator -s localhost -a Vault IMPORT “C:\Temp\Users.csu”
UVaultUserAccounts v3.0.0.0 - imports/exports ADMS user accounts
Copyright (c) 2012 Autodesk, Inc. All rights reserved.

user ‘Project Manager 1°
user ‘Project Manager 2°
user ‘Project Manager 3’
uset ‘Project User 1°

user ‘Project User 2°
user ‘Project User
user ‘Project User
user ‘Project User

2
3
4
5

C:\Program Files\Autodesk\UAD 2014>_

Export groups

VaultUserAccounts -u Administrator -s localhost -a Vault -g EXPORT "C:\Temp\Groups.csv”

&N Administrator: CA\WINDOWS\system32\cmd.exe | e

C:\Program Files\Autodesk\UAD 2014>UaultUserAccounts -u Administrator -s localhost -a Uault -g EXPORT "C:\Temp\Groups.cs[E
"

UaultUserfAccounts v3.0.0.0 - imports/exports ADMS user accounts

Copyright (c) 2012 Autodesk, Inc. All rights reserved.

group 'Office’

group 'Engineering’
group 'Email Send Group'
group 'Project 1°

group 'Project 2°

group 'Project 3°

C:\Program Files\Autodesk\UAD 2014>

We have exported to a CSV file called “Groups.csv” which looks like this:

A B C D E F

1 |Name Email Role Vault Group Enable

2 Office Vault 1
3 | Engineering WVault 1
4 | Email Send Group Vault 1
5 Project1 Document Editor (Level 2);Document Manager (Level 2);1tem Editor (Level 2)  Vault 1
6 Project 2 Document Editor (Level 2);Document Manager (Level 2);1tem Editor (Level 2)  Vault 1
7 Project 3 Document Editor (Level 2);Document Manager (Level 2);1tem Editor (Level 2)  Vault 1

Column A defines the name of the group.

Column B defines the name of the email address for the group.

Column C defines a list of roles that the group has been granted access to.
Column D define a list of vaults that the group has been granted access to.
Column E defines a list of groups that the group has been granted access to.

Column F is set to “1” for all users so that they are enabled.

Once you have made your manual changes to this CSV file, save it, and re-import with the syntax like:

VaultUserAccounts -u Administrator -s localhost -a Vault -g IMPORT "C:\Temp\Groups.csv”
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BN Administrator: C\WINDOWS\system32\cmd.exe

C:\Program Files\Autodesk\UAO 2014>VaultUserAccounts -u Administrator -s localhost -a Uault -g IMPORT "C:\Temp\Groups.cs|
T

UaultUserAccounts v3.0.0.0 - imports/exports ADMS user accounts
Copyright (c) 2012 Autodesk, Inc. All rights reserved.

C:\Program

group
group
group
group
group
group

Files\Autodesk\UAD 2014>

'Office’
'Engineering’
‘Email Send Group'
‘Project 1°
'Project 2°
'Project 3'

For larger implementations, this utility will save you a lot of time; even when using Active Domain user accounts.
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Import Object Properties

This functionality belongs to the administrative tasks and is only available through a command line interface (cmd.exe) on your
computer.

It is used in order to populate properties reading the values from a file. This file contains the entities, with the properties to be
updated and the values. Supported are file- and item properties.

Please note, that the properties will not be created — they must exist before.

Configuration

This utility allows you to update file and item properties from an external text file, such as for instance if one is migrating data
from a legacy document management system that also holds property data not present in the files.

This command line utility is located in C: \Program Files\Autodesk\VAO 2014 directory.

In a command window, typing the ImportObjectProperties.exe filename will display the syntax:

[N Administrator: CAWINDOWS\system32\cmd.exe = [=] 3

C:\Program Files\Autodesk\UAD 2014>ImportObjectProperties.exe
Usage: ImportObjectProperties [-t File|Item] [-a Vault|Windows] [-s sru] [-db dbase] [-u user] [-p pwd] [-1 d] [-e codep
age|name] filename

-t Type of object whose properties are being imported (default = File).

-a Authentication type (default = Vault).

-5 Name of server (default = localhost).

-db Name of database (default = Uault).

-u UserName for access to database (default Administrator).

-p Passuord for access to database (default = empty passuword).

-1 Logging lewel (d = Debug).
-e Encoding. Provide either codepage or name. (default = UTF-8).
filename C3U File which contains property values.

:\Program Files\Autodesk\UAD 2014>

Parameter Switch Description
Object Type -t Type for target object in Vault, must be match the content of csv file
Authentication Type | -a 2 possible values windows or vault
User -u Vault user to be used to connect and get files/folders from Vault
Password P Vault password to be used in conjunction with the above user name
Server - Server with Vault (Publisher server, in case of replicated systems)
Database -db Vault database to connect to
Logging - Level of Logging
Encoding -e Encoding. Provide either code page or name
Filename CSV file which contains property values and Item or file name

Note

e  This utility supports the importing into properties of following types: Text, Number, Boolean and Date.

e when importing into properties that have mapping defined then the mapping will override the data that is trying to
be imported, this is without error or warning

e when importing into properties that have list values the list will not be checked and so invalid data may be imported,
this data will be marked in the Autodesk Vault 2014 client

e when importing into properties of type NUMBER, that have a range value then out of range values may be imported
and so invalid data may be imported, this data will be marked in the Autodesk Vault 2014 client
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e When importing into properties of type BINARY then only values of True or False. Any other string will produce a null
string in the property.

e when importing into properties a null string may be used by defining filename,
filename,,property_2

e When importing into properties a null string may sent to a mandatory property, this data will be marked in the
Autodesk Vault 2014 client.

e When importing into properties only the first occurrence of the property will be used. For example the following file
would produce a new_prop_1 values of 1 not 2 for the file P100-A-00743.DWG

"

, property_2 in the file rather than

Name, new_prop_1,new_prop_2,new_prop_1
P100-A-00743.DWG,1,c0l2,2

e When importing into properties the file is read from top to bottom one line at time. Duplicate file names in the file
may mean data corruption. For example the following file would produce a new_prop_1 values of 2 not 1 for the file
P100-A-00743.DWG

Name, new_prop_1
P100-A-00743.DWG, 1
P100-A-00743.DWG,2

e  When importing into properties only file names that are distinct in the vault can be updated.

Usage
There are some rules that apply, for the import to be successful.
First, you need a text file something like below:

Name, Owner, Project Number, Header ,Purpose
Catch Assembly.iam, 1lst owner, 1, Catch Assembly, Testing
Combo Assembly.iam, 2nd owner,2, Combo Assembly, Testing
Pad Lock.iam, 3rd owner,3, Pad Lock, Testing

The top row contains the property names.

Importing File Properties

For importing file properties, the first column must be called “Name”, and contain the full filenames of the vaulted documents
to be updated.

Importing Item Properties

For importing item properties, the first column must be called “Number” and contain the full tem Number of the vaulted items
to be updated.

The following columns contain the property name, as it appears in Vault. These properties must be pre-configured in Vault. The
import will not create new properties for you; since there is no way of knowing the type and category application in advance.

Where the ADMS server computer is called “localhost”, we use the “administrator” login, with a blank password, to log into
the "Vault” vault, and the import text file called FileProperties.txt
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BH “tdministrator CiWindowshsystern3 2 crmd.exe

C:“Program Files“Autodesk“UAQ 2814>importobjectproperties —s localhost —-db Vault —u Administrator -p ° leProperties.t
et

ImportObjectProperties v3.B.1.8 — imports UDP values from CSU file
Copyright <c> 2812 Autodesk, Inc. All rights reserved.

Input file: ’'FileProperties.txt’
Number of rows: *3'

[1-31: Processing file ‘Catch Assembly.iam’...
Imported properties:

[2/3]1: Processing file ‘Combo Assembly.iam’...
Imported properties:

[3/3]1: Processing file ‘Pad Lock.iam’...
Imported properties:

IC:“Program Files“Autodesk\UAQ 2814>

The expected results should show that:

O D Mame State Rewvision LY Yersion Owener Project Humber

= File
% Pad Lock.iam Wfork in Progress A, (W] 3 3rd ovvner 3
% Combo dssemblyiam  Work in Progress &, 2 3 2nd ouwner 2
% Catch Assembly.iam Wiork in Progress A, @ 3 Lst cuwmer 1

All file properties have been updated accordingly.

55

iam x| v
Header Purpose
Pad Lock Testing

Combo Assembly  Testing
Catch &ssembly Testing
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Import Property List

This functionality belongs to the administrative tasks and is only available through a command line interface (cmd.exe) on your
computer.

It is used in order to import lists of values to UDP. This means that the lists of the user defined properties don't have to be
created manually. The UDP should exist upfront (before starting importing the property list) but the values itself get populated
into the UDP.

Configuration
This command line utility is located in C: \Program Files\Autodesk\VAO 2014 directory.

In a command window, typing the ImportPropertyList.exe filename will display the syntax:

[ Administrator: CAWINDOWS\system32\cmd.exe = || B 2%

1 »

C:\Program Files\Autodesk\UAD 2014>ImportPropertyList.exe
Usage: ImportPropertylList [-s sru] [-db dbase] [-u user] [-p pwd] [-t FilelItem] propertyName filename
-s Name of server (default = localhost).
-db Name of database (default = Uault).
-u UserName for access to database (default = Administrator).
-p Password for access to database (default = empty password).
-e Encoding. Provide either codepage or name. (default = UTF-8).
-t Property Type (default = File).
propertyName Property Name.
filename File which contains property values.

:\Program Files\Autodesk\UAD 2014>

Parameter Switch Example Value Notes

Server -s MyServer would be substituted with the applicable Vault server
name

Database -db Vault would be the Vault database name

User -u Administrator would be replaced with the login you wish to use

Password -p password needs to be included if a password is associated

Type -t File is File for a file property, and Item for an item based
property

Property name Source_Country is the Vault property name

Source File Countries.txt is the text file to import the values from.

Note

e The import replaces any previous list values, and so should be regarded as “new list” rather than “add to list”.

Usage

This is a command line tool that can be used to populate the configured list values of either file or item properties.

In a vault called “Demo1”, | have an item property called “Source_Country”, and this needs to cater for the following list:
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AUSTRALIA INDIA POLAND

AUSTRIA INDONESIA PORTUGAL
BELGIUM IRELAND RUSSIA

BRAZIL ISRAEL SINGAPORE

CHILE ITALY SLOVAK REPUBLIC
CHINA JAPAN SOUTH AFRICA
COLOMBIA LATVIA SOUTH KOREA
CZECH REPUBLIC LUXEMBOURG SPAIN

DENMARK MALAYSIA SWEDEN

ESTONIA MEXICO SWITZERLAND
FINLAND NETHERLANDS TAIWAN

FRANCE NEW ZEALAND THAILAND
GERMANY NORWAY UNITED KINGDOM
GREECE PANAMA URUGUAY

HONG KONG PERU USA

HUNGARY PHILIPPINES VENEZUELA

There is no way we want to have to manually enter all of these when creating the property in Vault.

So, we create the item property as a list type, with one value (does not matter what that is, since the import will overwrite the
existing list values of the property).

The end result is the populated list:

B weight

B Assembly ID

B Raw Material

7| S8P DOCUMENT NUMBER
)| Quality Factor

B Gasket Type

B W Type

B Material Group
B subtiltel

State Usage
S Ensbled
S Ensbled
" Enabled
" Enabled
‘% Enabled
‘% Enabled
‘& Enabled
‘@ Enabled
T Enabled
S Enabled
S Enabled
S Enabled
S Enabled

» P N D -

5

M Edit (User Defined) - Source_country.

Narne: Bource_country

Categoryvalues:

Value
S Enabled

Q, Searched
AUSTRALIA

"BUSTRALLS
False

False

Nane

', NDIA..

Name Value

Value
%5 Enabled

 searched
ALISTRALLA

s |False
False
None

Help

‘AUSTRALIA ", IND.

Property Walues

v ListWalues
#  Click here to add a nevw row
» o |AUSTRALLA
INDLA
POLAMD
ALSTRIA
INDONESIA
PORTUGAL
BELGILM
IRELAMD
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Remove
SetInitial Value

Close
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Import Folder Structure

This functionality belongs to the administrative tasks and is only available through a command line interface (cmd.exe) on your
computer.

It is used in order to import folder structure, apply categories, LifeCycle status, permissions and properties to folders. The
categories, users / user groups and UDP must exist upfront before starting the import.

Configuration

This is a command line tool that can be used to create/update a folder structure with assigning of folder categories and status,
user and user group permissions and properties.

At a windows command prompt, simply running the ImportFolderStructure.exe file will display the required syntax.

BN Administrator: C\WINDOWS\system32\cmd.exe = || B R

1" »

C:\Program Files\Autodesk\UAO 2014>ImportFolderStructure.exe

Usage: ImportFolderStructure [-a Vault|Windows] [-s srv] [-db dbase] [-u user] [-p pwd] [-e codepagelname] filename
-a Authentication type (default = Vault).
-s Name of server (default = localhost).
-db Name of database (default = Uault).

-u UserName for access to database (default Administrator).

-p Password for access to database (default = empty password).
-e Encoding. Provide either codepage or name. (default = UTF-8).

filename C3U File which contains folder information.

:\Program Files\Autodesk\UAD 2014>

Parameter Switch Description

Authentication Type | -a 2 possible values windows or vault

User -u Vault user to be used to connect and get files/folders from Vault
Password P Vault password to be used in conjunction with the above user name
Server - Server with Vault (Publisher server, in case of replicated systems)
Database -db Vault database to connect to

Encoding -e Encoding. Provide either code page or name

Filename CSV file which contains folder information

The Import Folder Structure command line tool can also be used to update existing folders.
Note:

e  Existing permissions would be override with the new permissions defined in the csv file
e  Properties will be override with the new properties in the csv file
e If a property doesn’t exist, the import folder structure will not create the property
e If a user or user group doesn’t exist, the import folder structure will not create the user/group
e If a user/group is missing in the csv file, they will have no access and view to that folder
o Therefor it's important to add each user or group to the route folder $ (see chapter Usage — Import folder
Structure)
e  User/group permissions are not propagated to subfolders
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Usage

The import folder structure allows creating or updating folders in Vault. This includes properties, Lifecycle status, categories and
user permissions.

The input file needs the following columns:

Column name Description Optional

Path Path in Vault explorer No

ACL Read read permission for the specific folder | Yes —if no value is set, the user / group have no
(1 =allow, 0 = deny) permission

ACL Write write permission for the specific folder | Yes — if no value is set, the user / group have no
(1 =allow, 0 = deny) permission

ACL Delete delete permission for the specific Yes — if no value is set, the user / group have no
folder (1 = allow, 0 = deny) permission

User Group Name User or group name No

Category Folder category Yes — if no category is set, the default folder category will

used

State Status for folder if they has assigned a | Yes — default status will be used if no value is available
lifecycle

UD Property Each UDP which is defined and Yes
assigned to folder category

Each path must be added to the csv file with the specific permissions; especially for the root folder. Otherwise the user will
have no longer access to each subfolder.

New Structure

Import a folder structure for Projects in Vault based on existing structure used in other applications. The structure can be
created in a cvs file (or excel) and will include some information and user permissions. The following example creates 3 new
Project folder names Project A, Project B and Project C.

Path,ACL Read,ACL Write,ACL Delete,User Group Name,Category,State,Project,Project Number,Description
$,1,1,1,Administrator,,,,,

$,1,1,,Everyone,,,,,

$,1,,,Project 1!!!!!

$/1111Pr0jeCt 2/////

$/1111Pr0jeCt 3/////

$/Projects,1,1,1,Administrator,,,,,

$/Projects,1,1,1,Project Manager 1,Project,,,,

$/Projects,1,1,1,Project Manager 2,,,,,

$/Projects,1,1,1,Project Manager 3,,,,,

$/Projects,1,,,Project User 1,,,,,

$/Projects,1,,,Project User 2,,,,,

$/Projects,1,,,Project User 3,,,,,

$/Projects/Project A,1,1,1,Administrator,,,,,

$/Projects/Project A,1,1,1,Project Manager 1,Project,Pending,VAO 2014,2014300,AC Consulting FY 2014

$/Projects/Project A,1,1,,Project User 1,,,,,

$/Projects/Project A,1,,,Project Manager 2,,,,,

$/Projects/Project A,1,,,Project Manager 3,,,,,

$/Projects/Project B,1,1,1,Administrator,,,,,

$/Projects/Project B,1,1,1,Project Manager 2,Project,Pending,VAO 2013,2013200,AC Consulting FY 2013
$/Projects/Project B,1,1,,Project User 2,,,,,

$/Projects/Project B,1,,,Project Manager 1,,,,,

$/Projects/Project B,1,,,Project Manager 3,,,,,

$/Projects/Project C,1,1,1,Administrator,,,,,

$/Projects/Project C,1,1,1,Project Manager 3,Project,Pending,VAO 2012,2012100,AC Consulting FY 2012
$/Projects/Project C,1,1,,Project User 3,,,,,

$/Projects/Project C,1,,,Project Manager 1,,,,,

$/Projects/Project C,1,,,Project Manager 2,,,,,

In the command line run:

ImportFolderStructure -s localhost -db Vault "ProjectFolders.csv"
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BN Administrator: CAWINDOWS\system32\cmd.exe

C:\Program Files\Autodesk\UARD 2014>ImportFolderStructure ProjectFolders.csu
ImportFolderStructure v3.0.0.0 - imports folder structure from CSU file
Copyright (c) 2013 Autodesk, Inc. All rights reserved.

Input file: 'ProjectFolders.csv’
Number of rows: "27°

Processing path °

Processing path *

Processing path °

Processing path *

Processing path '§'.

Processing path '$/Projects’.

Processing path '$/Projects’.

Applying category 'Project'

[8/27] Processing path '$/Projects’.
[9/27] Processing path $/PrOJects'
[10/27] Processing path "$/Projects’.

[

Update Structure

It is also possible to update (or add) the existing folder structure. Therefore the following example add a new Project folder and

assign new users to existing projects. The bold marked columns are the new information.

Path,ACL Read,ACL Write,ACL Delete,User Group Name,Category,State,Project,Project Number,Description

$,1,1,1,Administrator,,,,,
$,1,1,,Everyone,,,,,

$1111PronCt 1!!!!!

$11111PronCt 2!!!!!

$,1,,,Project 3,,,,,

$,1,,, Project User 4,,,,,

$,1,, Project User 5,,,,,
$/Projects,1,1,1,Administrator,,,,,
$/Projects,1,1,1,Project Manager 1,Project,,,,
$/Projects,1,1,1,Project Manager 2,,,,,
$/Projects,1,1,1,Project Manager 3,,,,,
$/Projects,1,,,Project User 1,,,,,
$/Projects,1,,,Project User 2,,,,,
$/Projects,1,,,Project User 3,,,,,
$/Projects,1,,,Project User 4,,,,,
$/Projects,1,,,Project User 5,,,,,
$/Projects/Project A,1,1,1,Administrator,,,,,

$/Projects/Project A,1,1,1,Project Manager 1,Project,Pending,VAO 2014,2014300,AC Consulting FY 2014
$/Projects/Project A,1,1,,Project User 1,,,,,

$/Projects/Project A,1,1, ,Project User 4,,,,,

$/Projects/Project A, 1, PrOJect Manager 2,,,,,

$/Projects/Project A,1,,,Project Manager 3,,,,,

$/Projects/Project C,1,1,1,Administrator,,,,,

$/Projects/Project C,1,1,1,Project Manager 3,Project,Pending,VAO 2012,2012100,AC Consulting FY 2012
$/Projects/Project C,1,1,,Project User 3,,,,,

$/Projects/Project C,1,1, ,Project User 4,,,,,

$/Projects/Project C,1,1, ,Project User 5,,,,,

$/Projects/Project C,1, PrOJect Manager 1,,,,,

$/Projects/Project C, 1,,,Project Manager 2,,,,,

$/Projects/Project D,1,1,1,Administrator,,,,,

$/Projects/Project D,1,1,1,Project Manager 1,Project,Pending,VAO 2015,2015400,AC Consulting FY 2015
$/Projects/Project D,1,1, ,Project User 1,,,,,

$/Projects/Project D,1,1, ,Project User 4,,,,,

$/Projects/Project D,1,, ,Project Manager 2,,,,,

$/Projects/Project D,1,, ,Project Manager 3,,,,,
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Object Link Browser

This functionality is used to show the links of files, folders, items and change orders.

Configuration

There is no configuration needed.

Usage

Please follow these instructions to use the object link browser functionality:

61

1.
2.

Select a file, folder, item or change order entity in the Vault Client.
Click on the Links tab to show the link information for the selected entity.

History | Uses | Where Used

Change Order

Preview

Classification

Links

Mame
=3 s
=T Object Links

58 ZWHL .dwg
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Troubleshooting

Event log

All exceptions in the Vault Add On are being logged to the Windows event logging mechanism. They can be seen using
standard Event Viewer application. The log contains the error message and full stack trace.

Unable to load Vault Add On

If Vault is not able to load a plugin, it just throws an exception which doesn’t contain any additional information. It is therefore
hard to determine why it can’t be loaded.

To get additional information, there’s a tool on the It's just ones and zeros blog which helps to get more information about the
issue:

http://justonesandzeros.typepad.com/blog/2011/05/extension-deployment-checklist.html

How to use it:

Download the tool

Copy the executable into your Vault Client program folder
Run the tool

Point to your Vault extension and click on Load

Analyse the output

hwNn=

Missing stdole.dll

If, as a result of the above procedure, the stdole.dl1l library is missing from the Explorer folder in Vault, use Microsoft
Windows Search capability to locate it in the system and copy it to the Explorer folder.

Unblock assemblies

Sometimes it happens that when assemblies are being copied from a ZIP archive that they have to be unblocked before the first
use.

This is the case if you encounter following message: “Attempt was made to load assembly from a network location”.
To unblock the assembly, do the following:

1. Right-click on the assembly in windows explorer
2. Open the Properties
3. Click on Unblock in the General tab

Installation Issues

If you have issues with the installation then the *.msi can be run manually to generate a log file of the install. To run the install
manually follow these steps.

Copy the Vault Addon 2014-Complete-n.n.n.zip to a local directory and unzip.

Open a command window at the location of the *.msi file that matches you operating system version.
Run the *.msi manually using msiexec /i VaultAddOn.msi /L install vao.log

Follow the steps above and then review the log file.

PWN=

Post Install Enterprise Add-On for Autodesk Vault 2014 Issues

If the Enterprise Add-On is not in the Tools menu then you will need to reset the menus. To make the commands visible in
Vault Client, it's required to reset the menu:

1. Run Vault Client and connect to your Vault server.
2. InVault Explorer go to Tools > Customize.
3. On Toolbars tab select Main Menu then press Reset. This step will “reset” user interface to default state.
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User Rights Issues

It has been documented that sometimes User Rights are not properly set for Enterprise Add-On for Autodesk Vault installation
folders and files.

It is then recommended to check that the current user belongs, at minimum, to Power User Group as well as this group has to
be added to the Enterprise Add-On for Autodesk Vault installation folder

C:\Program Files\Autodesk\VAO 2014\

Special characters in CSV files

Some of the VAO components are working with CSV files. If special characters (like 6auééé) are used, the CSV files have to be
encoded in UTF-8. Some VAO components additionally allow specifying the used encoding as well.

Email Notification — missing address

If you get the following message: “The parameter ‘address’ cannot be an empty string” while sending an email notification,
make sure that you're using correct email addresses.

The Email Notification requires for both sender and recipient a valid email address. The address for the sender is being taken
from the currently logged in Vault User.
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Good to know - FAQs

Visualization files

Please note that Vault client recognizes only DWF file when displaying preview of the document. This means that even if you
set the attachment as a visualization file (AttachAsVisualization = True) it won't be displayed in the preview tab. However it will
be correctly displayed when you select attached file (e.g. the pdf file) directly in the main pane.

Logout

P Eror 300 28

| Your account has been automatically logged out of the Autodesk
data management server. You must log in to access the vault.

An automatic logout after 30 minutes has been reported in Vault 2012 Collaboration. This happens only on machines which
have VAO 2012 installed

This is a standard behaviour which affects all custom applications. If user is inactive for 30 minutes then the license is
automatically released. If standard command is used after this time it automatically reconnects to the server. If custom
command is used then you may get an error 300. The solution in this case is to use standard command (i.e. Refresh) and then
use custom command (e.g. VAO command).

Application Error

Application Error — @

After installing the VAO it could happen that during the start of Vault Client an error message appears. To identify the reason
look into Windows Event Viewer to find any messages there. Expand the Windows Logs for Application and filter for Level Error
and VAO.

> [3 Custom Views

4 [w Windows Logs
] Application Level Date and Time Source EventID Task Category

& Security 29/07/2013 09:15:27 VAO.EmailNoti...
= Setup '@'['Error 29/07/2013 09:14:31 VAO.EmailNoti... 0 MNone

“F  Filtered: Log: Application; Level: Error; Source: . Number of events: 2,882

In the Source column you will find the VAO feature which will cause the error. If you don’t need the feature, go to Programs
and Features and uninstall the component. In any other cases, check the configuration or ask Autodesk Consulting for support.
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Localization

If the VAO is being used on non-English environments, it's required adopt the provided template configurations to the used
language.

This includes the renaming of the English names of following elements:

e  Property names
e  Categories
e Life Cycle Definitions/Names

Send E-Mail Notification via ADMS

If you want to use the VAO Email notification and however the client is not allowed to contact the SMTP server directly (port
25 blocked to the client subnet). The ADMS server can send email to an SMTP server on port 25 as normal and therefore the
following steps describe how to set up the ADMS server to work as an SMTP server:

1. On ADMS server install SMTO server software
a. Server Manager -> Features -> Add Features -> SMTP Server
b. Install all extra software that is required a prerequisite
2. StartlIS 7.0 Manager
a. General tab -> Advanced -> change port on all unassigned to 60000
Access tab -> Authentication -> add Anonymous access
Access tab -> Authentication -> add Basic authentication
Access tab -> Relay -> switch radio button to “All except the list below”
Delivery tab -> Advanced -> smart host -> “set to SMTP server, the working on”

mDeno

This should mean that the ADMS server can receive mail on port 60000 and send to SMTP server on 25.

3. Configure the xml for VAO
a. Host=ADMS Server
b. Port=60000
c. Login = Valid user on the machine
4. Update Vault with VAO import of xml and restart the client

This means that when the client life transitions from state to state the process is called to send SMTP mail on port 60000 to the
ADMS server, this server then passes the mail to real SMTP server for sending to the real world.
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Support

Customers and Partners are entitled to be directly supported by Autodesk Consulting in case of a valid “Autodesk Solution
Support” contract. (Separate services offering)

The subscription entitles customers to get all available updates, versions, hot-fixes and service packs of the Enterprise Add-On
for Autodesk Vault. Defects are also handled under the subscription contract. Support is not included in the subscription.

The support model and process looks like this

Support Process Overview

AC Vault Add-on
SME / Engineer

AC Solution Support Team

VAR
Direct "
f N Customer
Direct
Customer Customer
| oustomer il Oustomer

Autodesk

1. In case of accepted defects, direct customers and Autodesk Channel Partners are directly sup-ported by Autodesk if a valid
subscription contract is in place

2. Direct Customers are directly supported by Autodesk Consulting in case of a valid “Autodesk So-lution Support” contract.

Indirect Customers are supported by their Autodesk Channel Partner.

4. The Channel Partner is supported by Autodesk Consulting in case of defects in the Enterprise Add-On for Autodesk Vault
and in case of a valid “Autodesk Solution Support” contract (for all related questions).

w
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